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Introduction 
UVPaint is designed to streamline and improve your workflows when working with multiple 
materials, UDIMS, texturing, sculpting and painting. 
 
For Studio or BodyPaint users UVPaint also contains a real-time projection painting brush built 
on top of the sculpting system. It allows you to paint stamps, stencils and regular brush dabs 
down onto your Polygonal Models directly in the OpenGL viewport of Cinema 4D. It works with 
the same BodyPaint interface and allows you to paint on any layer or mask that is selected in 
BodyPaint. 

Compatibility 
UVPaint will only work with version R17, and above, of MAXONs Cinema 4D or BodyPaint 3D.  
 
To use the Paint Brush you must have the sculpting system. This is only part of Cinema 4D 
Studio or BodyPaint 3D. 
 
For R17 you must have the latest service pack SP3, ie version R17.053.  

Features 
1) Advanced Material View 
2) UDIM workflow support 
3) Content View designed specifically for Texturing and Sculpting workflows. 
4) Camera View to speed up navigating your scene with custom views. 
5) A Real-Time Projection Painting Brush to paint directly in the OpenGL Viewport 
6) Paint with Stencils 
7) Paint with Stamps 
8) Use any Cinema 4D Material as a Stencil or Stamp 
9) Use all the Sculpting Symmetry features 
10) Fill all UV Islands with a random color per island 
11) Fill all UV Islands with the current color 
12) Fill selected polygon 
13) Use Fill Modes to project Stencils onto Geometry 
14) Restrict Painting to only the selected Polygons 
15) Quick Fill Polygons with Stencils or Color 
16) Edge Detection is supported for filling 
17) Paint onto the selected Layer(or Mask) in BodyPaint 
18) Paint into Multiple Channels Simultaneously 
19) Use the selected colors specified in BodyPaint 

 

Copyright © 2016 GameLogicDesign Ltd  Version 1.1.9 

 



 
 

20) Sculpt and Paint at the same time 
21) Mix Surface Textures using a Fusion Shader and Mask Image 
22) Update the Relief Object in real - time while painting 
23) Paint onto Multiple Materials 
24) A post Bleed operation to fix up uv seams 
25) Support for Wacom Tablets 
26) Supports 8 / 16 / 32 bit images 
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Installation 
To install the plugin just copy the ‘gld_uvpaint’ folder directly into the Cinema 4D/plugins 
directory.  
 
When you next run Cinema 4D you will be notified that the plugin does not have any licence 
number. A dialog box will appear to allow you to input the required licence number for this 
plugin. 
 

 
 
Copy the licence numbers for the plugin into its corresponding box and press ok to continue.  
 
You will have received these numbers via an email after purchasing the plugin. 

Using a License Server 
If you have purchased a license server version then simply paste in the licence keys that you 
were emailed directly into the license server.  
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Add the Brushes to the UI 
Now that you have the plugin successfully installed and licensed you will want to add the 
brushes to your interface. 

The Brushes 
There are 2 brushes that come with the UVPaint plugin.  

Paint Brush  
This is the main brush. This is the brush you will use for all the tutorial videos and workflows in 
this document. It applies paint to the materials on your objects. 

Paint and Sculpt Brush  
This is a bonus experimental brush. It will allow you to paint and sculpt at the same time. More 
features will be added to this brush in future updates but for now you can treat this brush as 
something fun to play with. You will need to do 2 undo’s to undo each brush stroke if you use 
this brush. Since it applies a sculpt stroke and then a paint stroke afterwards. 
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Use the provided UVPaint Layout 

 
 
We have provided a custom layout that contains both of the paint brushes. It also contains the 
Make Editable button for those times where you forgot to turn your model into a polygon object. 
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In C4D goto Window->Customization->Load Layout 

 
 
Load the UVPaint.l4d file from the layout folder within the unzipped UVPaint folder. 
 
Now that the layout is loaded you will need to save it again so select 
“Window->Customization->Save Layout as...” 
 

 
 
The name will already be UVPaint.l4d so just click Save. 
 
The UV Paint layout will now appear in your layouts dropdown on the top right of C4D. It will be 
listed as UVPaint (User). 
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Make Custom Layout 
 
These tools work with BodyPaint, so first switch to the BodyPaint Layout. 
 
Next we will add the paint brushes to this layout.  
 
Right Click on an empty part of the Tool Bar and select “Customize Palletes”, or alternatively 
you can select Window->Customization->Customize Palletes. 
 
Next enter the name “GLD UVPaint” into the name filter. 
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You will see 2 bushes appear in the list.  
 
Drag the both of the brush icons onto the interface where you would like to be. We would 
suggest docking it under the existing BodyPaint Brushes on the right hand side of your screen. 
 
Lastly we want to save the layout with these new tools. Following these steps to achieve this. 
 

1) Choose Window->Customization->Save Layout As. 
2) Give the layout a name like “UVPaint” 
3) Save the layout.  

 
You should now be in the new layout you have just created. And under the layout dropdown, on 
the top right, you will see “UVPaint (User)”.  This layout now has your two new paint brushes on 
it ready to go. 
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Painting  
Now that we have the brushes on the interface we would like to start painting. But first it is 
important to know a few things about the brush so that you can get the optimal performance 
when using it. Please be sure to read everything in the next section carefully. 
 

Before We Begin 
There are a number of other things you need to be aware of to ensure a fast update speed for 
your painting brush while in OpenGL. We will outline these next… 

Paints on Polygon Objects Only 
The paint brushes only work on Polygon Objects. So any procedural objects that you have in 
your scene will need to be made editable before you can paint on them.  
 
Also the brush will only work on one selected object at time. 

Set the Material Texture Preview Size 
To speed up painting it is advisable to set the Texture Preview Size for a material to No 
Scaling. Although painting will work if this is not set, it may result in a much slower painting 
experience.  
 
If you ever find your paint brush going slowly this is the first thing you should check. 
 
If it is not set then C4D will continuously sample the texture you are painting on. It samples it so 
that it can display a lower resolution version in OpenGL. This process slows down the painting 
system. Setting it to No Scaling will use the full resolution texture directly on the object in 
OpenGL and no sampling will occur. 
 
We also want the full resolution texture being displayed on the model so that we can see the 
details of the texture. So have a sampled down version is not actually useful for painting 
workflows. 
 
Double click on your material and switch to the Editor Tab. Then make sure the “Texture 
Preview Size” is set to “No Scaling”. 
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Use Texture Sizes that are power of 2. 
OpenGL likes images that are powers of 2. In some cases if they are not then it will upsize the 
image to ensure that it is. This causes additional computations that will just slow the brush 
down.  
 
By making sure your textures are 256x256, 512x512, 1024x1024, 2048x2048 etc… will help 
ensure that the brush will get all the speed it can. 

User Smaller Brush Sizes or increase your Stamp Spacing 
If you find the brush is going slowing try increasing the stamp spacing. Sometimes you don’t 
need to draw so many dabs onto the object to get the result you need. By increasing the stamp 
spacing it means it will do less drawing per stroke, which results in a faster brush performance.  
 
Having a smaller brush size will help as well.  
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Together you can adjust your brush so that it will perform at its optimum speed while not 
causing any reduction in quality of the final textures. 
 

Multi-Channel Painting 
If you are going to paint on multiple channels at the same time then you need to ensure that the 
textures are all the same size on every channel you are painting.  
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Lets Paint! 
This is a quick overview to show how to paint. You can also watch the first video on the 
Features page for the Paint Brush to see these steps in use. 
 
Here we are going to paint on a single material on a simple primitive. 
 

1) Create a Sphere 
2) Make the Sphere editable.  
3) Create a material 
4) On the Materials Editor Tab, change the Texture Preview Size to “No Scaling” 
5) Drag the material onto the Polygonal Sphere 
6) Switch to our new PaintBrush layout we created earlier. 
7) Switch to the Material tab in BodyPaint 
8) Click on the red X to enable the material 
9) Double click on the x under the “Color” channel 
10) Create a 2048x2048 texture and click OK. 
11) Select the new Paint Brush. 
12) The Interface will now switch to OpenGL 
13) Make sure your viewport display is set to Gouraud Shading. 
14) Start painting on your model. 
15) Change the color of the brush from the Colors tab in BodyPaint. 
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Using the Paint Setup Wizard 
You can also use the built in Paint Setup Wizard provided by BodyPaint to add materials and 
textures to your models. 
 

 
 
Just make sure that after you have created these materials that you set the “Texuture Preview 
Size”  to No Scaling for the Material before you start painting. Again this option can be found on 
the Materials->Editor tab. 
 
 
 
Select the objects that you want to paint. This dialog will show all the objects that you have 
selected in the viewport. 

  
 
 
UV Map the objects if you need to using the Automatic UV mapping options... 
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Enable the channels that you want to paint on then set the texture size for your object. Make 
sure to disable the “Automatic Mapsize Interpolation” setting so that all the texture maps end up 
being the same size. 

 
 
Now the objects will be setup and ready.  
 
Lastly Select the Paint Brush tool and then begin painting on your model. 
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Paint with Stamps 
First follow all the steps from the above “Lets Paint!” section. 
 
Note: Stamps require intersecting points on the mesh itself to work. If your model is low 
resolution then follow these steps first ensure you have enough points to work with. 

1) Switch to the sculpting tab 
2) Subdivide your model by using the Sculpting Subdivide button to give it more points to 

work.  
3) When you now paint on your model using a stamp it will hit at least 1 point and the 

stamps will be placed correctly. 
4) When you are finished painting you can simply delete the sculpt tag from your model. 

 
Now do the following 

1) Change the Stamp Tab 
2) Drag and drop an image from your computer into the “Image” field 
3) Change back to the Settings tab 
4) Enable Stamp Spacing 
5) Set the Stamp Spacing to 50 
6) Change the Pressure value all the way up to “100%” 
7) Draw a brush stroke on your model. 
8) Lower the Stamp spacing to your liking 
9) Enable “Steady Stroke” 
10) Adjust the Steady Stroke Length to get a smooth brush stroke 
11) Change to the Stamp Tab 
12) Enable the “Follow” option 
13) Draw on your model again to see the stamp rotate as your draw. 
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Paint with Stencils 
First follow all the steps from the above “Lets Paint!” section. 
 
If you followed the last steps from Stamps then you should either Clear the Stamp or uncheck 
the “Use Stamp” checkbox.  
 
Now do the following 

1. Switch to the Stencil Tab 
2. Drag and Drop an image into the “Image” field of the Stencil Tab 
3. Position the Stencil over your model by holding down the “T” key and dragging the 

stencil around in the viewport.  
a. Note: If the T key is not setup on your machine then you can set your own hot 

key by searching for “Sculpt Brush Stencil Adjust” in the command manager and 
assign your own override key for this feature. This key will override any other 
hotkey you have set up, but ONLY when you have a sculpt brush selected, such 
as the Paint Brush. 

4. Start painting on the stencil to push the texture down onto your model. 
5. If the texture is too light then make sure to change the Pressure Value up to 100% 

 

 

  

 

Copyright © 2016 GameLogicDesign Ltd  Version 1.1.9 

 



 
 

Multi Channel Painting 
You can also paint multiple textures down at the same time onto individual channels. The way 
this is done is by using a Material with the images in each of its channels. If you have the same 
channels ready for painting on the material on your model then the paint brush will paint the 
textures from the source material directly into the corresponding channels of the material on 
your model. 
 
To ensure this works there are a number of things to setup... 
 
On your destination material make sure you have all the textures setup in BodyPaint ready to 
paint. These textures should all be the same size. 

 
 
Enable MultiMap in the BodyPaint by clicking the white squares on the left side and then also 
activating each of the channels by clicking on the little pen icon on each of the channels.  
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Create a material to paint with and ensure you have the textures in the same channels that you 
are going to paint into. 
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Select the Paint Brush and switch to the Stencil Tab. Drag the material into the “Material” slot on 
the Stencil Tab. 
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Set your System Preferences to use a larger sampling size for the material so that you can get 
more detail from the channels when painting. 
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If you have dragged in a Substance material then also make sure that the Substance channels 
are also set to the same value or higher. 

 
 
Back on the Stencil Tab check the “Multi-Map Painting” checkbox. This will tell the Paint Brush 
to use all the available channels on the material for painting. After checking the box click the 
“Sample Material Channels” button to sample at the resolution you set in the preferences.  

 
 
You will see status bar updates to show what channels it is sampling. This can take time 
depending on how large you have set the stencil material sampling size. 
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You can now paint the material, using all the channels, onto the model. If it doesn’t paint then 
just go through this checklist to make sure everything is set. 
  

1) The object your painting on must be a Polygon Object. Make sure you make your 
models editable. 

2) Is the MultiMap option in BodyPaint enabled? 
3) Are all the Channels enabled for painting by clicking the little pencil icon on the 

channels? 
4) Have you sampled the material channels using the “Sample Material Channels” option 

on the stencil tab? 
5) Is the texture resolution in the Preferences set high enough? 
6) Are the layers you are painting on visible in BodyPaint? Check the Layers tab to see if 

you have turned off a layer but still have it selected for painting. 
 
Note: When you disable the “Multi Map Painting” option it will simply use the Color channel of 
the material and paint that into all of the channels enabled. 

Normal  Maps 
For normal map painting to work the image in the source materials normal map channel must 
also be a normal map. The brush projects the paint from the source to the destination. This 
means you can NOT use a greyscale image as your normal map source and expect to get a 
proper normal map in the resulting image. You should also make sure that the destination 
image is an RGB image and not a greyscale image.  
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Paint Brush Features 
The features of the Paint Brush are largely similar to the features in the Sculpting System. Since 
the Paint Brush is built ontop of the same toolset as the Sculpting Brushes you can learn alot 
about how the tools work by also reading the Sculpting Documentation found in the Help for 
Cinema 4D.  
 

Settings Tab
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Brush Preset 
Used to save and load brushes with all the settings for the brush. 

Size 
The Size of the Brush Dab 

Pressure 
The pressure of the brush. Less pressure will apply less paint.  

Steady Stroke 
When enabled it will allow you to create smoother strokes by having the painting lag slightly 
behind the brush cursor. This helps avoid shaky lines being drawn. 

Length 
Adjust to set the distance the brush should lag behind when doing a steady stroke. 

Spacing 
The distance between brush dabs.  
 
This is actually a percentage of the brush size itself. The default is 20, meaning the brush will 
move 20% of the size of the brush before drawing another dab. This will result in the brushes 
overlapping by 80%. This default value of 20 gives a nice uniform brush stroke. 
 
A value of 100 will mean it will go the full distance of the brushes size before drawing a dab, so 
in this case you will not see any overlapping dabs on the surface. 
 
To speed up painting you can increase the stamp spacing so that it doesn’t draw as many dabs 
on the surface as you paint. This is perfectly acceptable for all the current brush algorithms 
available in this brush.  

Percent 
The percentage of the brush size to move before placing another paint dab onto the surface. 

Edge Detection 
This can be used to fill parts of the surface based on its curvature. If you enable this option and 
click on a flat part of a model it will fill all the polygons until it hits a curved part of the model.  
 
You can adjust the angle of detection using the Angle slider. 
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Angle 
Specify the angle of curvature that the brush should stop drawing.  

Draw Modes 
These are the modes that you can use to apply paint to the surface. The main brush is the 
FreeHand brush. You can also draw lines and use fill tools as well. 

Freehand 
This is the main brush. Think of this as a normal paint brush. 

Line 
Click anywhere in the viewport to mark points on a line. When you are finished defining the line 
you can either double click, or right mouse click, to draw the line.  Pressing the ESC key will 
abort the line drawing. 

Fill Tools 

There are 3 fill tools. These all need to overlap points on the mesh to work. If the selected area 
does not include any points on the polygons you intend to fill, then no paint will applied. Please 
read the rest of this document to find out more about this limitation and also how to work around 
it by subdividing your model. 

Lasso Fill 

Draw a lasso selection on the model that you wish to fill. 

Poly Fill 

Draw a polygon, defined by straight lines, that you wish to fill. 

Rectangle Fill 

Drag out a rectangular shape that you wish to fill. 

Fill Symmetry 
When using any of the fill tools you can choose to enable symmetry. If this option is enabled, 
and you have some symmetry setup, then it will fill the symmetrical areas as well. Disabling this 
option will only apply paint to the area defined by the fill shape that you have drawn. 

Fill Backfaces 
When enabled it will also apply any paint to any backfacing polygons. This is useful if you wish 
to project paint onto the entire model by doing a rectangle select over everything. With this 
option enabled it will then apply paint to all the polygons. 
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Fill Full Polygon 
When enabled it will fill any polygons completely with the color, or stencil, that you have setup. 
This enables a very fast workflow for blocking out parts of the model. This method is much 
faster than regular painting since it does not need to take into account the radius of the brush, 
and can just flood fill any polygon that the brush touches. 

Fill All 
This will flood fill all the polygons on the model. If you have a current selection then it will only 
flood fill the selected polygons. 

Fill UV Islands 
This is a handy utility to simply flood fill all the UV Islands on the model with a random color. 
This allows you to visualize the various UV spaces on your object before you start painting. 

Bleed 
Use the bleed options to extend out the pixels from the UV boundaries. This will eliminate any 
seams that you might have on your model. 

Falloff Tab 

 
This tab behaves exactly the same as described in the Sculpting documentation. You can adjust 
the falloff curve to define the shape of your brush dab. 
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Stamp Tab 

 
This tab behaves exactly the same as the sculpting system with the exception of the additional 
option at the bottom.  

Use Stamp Color 
When enabled the brush will paint the color of the stamp onto the surface of the object.  
 
If it is disabled then it will be used as a greyscale image and will be multiplied against the 
current color you have selected for your brush on the BodyPaint Color Tab. This allows you to 
apply a alpha based stamp using a specific color to your objects.. 

Use Alpha Channel 
If you are using an image that contains an alpha channel, such as a PNG file, then this option 
will be available. When you enable it the paint brush will use the Alpha Channel with the Color 
Channel allowing you to create precise stamp shapes for painting with.  
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Using Stamps with Fill Tools 
Usually you will use Stamps with the Freehand Mode for the Paint Brush. But the stamps also 
work with the Fill Tools in a unique way.  
 
If you use the Rectangle or Lasso Fill Modes, found on the Settings Tab under Draw Modes, 
then the brush will fill the selected area with the pattern defined by a single brush dab. A small 
area will draw a small stamp, a large area will draw a large stamp.  
 
In the following example you will see that the exact same stamp image has been applied so that 
it fills the selected area on the surface. 
 
Small Lasso Fill 

 
 
Large Lasso Fill 
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Stencil Tab 

 
This tab behaves exactly the same as the sculpting system with the exception of the two options 
at the bottom. Refer to the section on Multi Channel Painting to find out more about what these 
options do. 
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Display Tab 

 
 
The Update Objects option can in most cases be set to Never.  
 
This option will force the object you are painting on to tell Cinema 4D that it has changed. If the 
object then uses the texture for some other purpose, such as real time displacement, then it will 
update directly in the viewport based on the option you have set. 
 
This option can be used to do things such as 

- Paint a Texture used on a Displacer Deformer 
- Paint a texture used in a Fusion Shader for a Mask to mix 2 shaders together. 
- Paint on a texture used in a Relief Object. 

Never 
It will never update the object. In most cases this is the desired setting. Updating the object can 
cause extra computations to occur depending on what the object is and what it is using the 
textures for. Leaving this set to Never will ensure your painting is working as fast as it can. 

During Stroke 
Will update the object for each dab that is drawn on the surface, as you are painting. 

After Stroke 
Will update the object after you have finished a brush stroke. 
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Fill Selected Polygons 
If you are in Polygon Mode you can make a selection using the regular C4D selection tools. The 
Paint Brush will respect the selection and only apply paint to these selected polygons. 
 
Pressing the Fill All button will fill the currently selected polygons with the color defined in 
BodyPaint. 
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Applying a Texture Bleed 
To remove seams from your model you can use the Bleed option on the brush. This will bleed 
out the texture along the UV boarders out into texture space for each active channel on your 
currently selected material. 
 
You can specify the amount of texture bleed using the adjustment slider. This slider represents 
the number of pixels to bleed out from the edge of the uvs. 
 
No Bleeding (2048x2048) 
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10 Pixel Bleed (2048x2048) 

 
 
 
 
  

 

Copyright © 2016 GameLogicDesign Ltd  Version 1.1.9 

 



 
 

50 Pixel Bleed (2048x2048) 
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Hot Keys 
The following hotkeys are all standard in the Sculpting System. Where appropriate the hotkeys 
have been overridden to work with a painting workflow, but for most of them they work exactly 
as described in the Cinema 4D document for Sculpting. 

Ctrl + Shift + Click Drag 
- Move the mouse, or tablet pen, Left/Right to adjust the brush size 
- Move the mouse, or tablet pen, Up/Down to adjust brush pressure 

Shift  
Switches to a smooth brush to the apply a basic smooth filter to the surface. 

Ctrl 
Switches from the foreground color to the background color set in BodyPaint. 
 
In this example the brush will paint yellow when not pressed, but when the Ctrl Key is held down 
it will paint black. 

 

T - Transform Stencil 
By default the sculpting style brushes have the T key set to transform a stencil in the viewport. 
By holding down this hotkey you can do the following 

- Left Mouse Click to move the stencil 
- Right Mouse Click to scale the stencil 
- Middle Mouse Click to rotate the stencil 

 
If the T key is not setup on your machine then you can set your own hot key by searching for 
“Sculpt Brush Stencil Adjust” in the command manager and assign your own override key for 
this feature. This key will override any other hotkey you have set up, but ONLY when you have 
a sculpt brush selected, such as the Paint Brush. 
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Q - Hide/Show Stencil 
Tapping the Q key will hide or show the stencil in the viewport.  This hotkey toggles the “Visible” 
option on the Stencil Tab 

Symmetry Hotkeys 
Alt + X: Toggle X Symmetry 
Alt + Y: Toggle Y Symmetry 
Alt + Z: Toggle Z Symmetry 

W - Hide/Show Wireframe 
Tap the W key to show/hide the wireframe for the selected Polygon Object. 
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Additional HotKeys 
There are many other additional hotkeys you can set for all the sculpting style brushes if you 
need them.  

Note about Tool Overwrites 

Note that sculpting hotkeys have the special ability of overriding other hotkeys you might have 
set in Cinema 4D, but only when you have a sculpt brush selected. If a tool other than a sculpt 
style brush is selected then it will use the previously set hotkeys. This allows you to use any key 
that you want for sculpting/painting style workflows without worrying about deleting hotkeys 
used elsewhere in c4d, such as for modeling. 
 
You will know if a tool is one of these special overrides by looking at the “Restrict to” section in 
the command manager. If it says “Tool Overwrite” then you will know it is safe to choose any 
key you want and it will only ever be used when you have a sculpt style brush selected, such as 
this Paint Brush. 
 

 
 
Search for them in the Command Manager (Window->Customization->Customize Commands).  
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Freehand 
Set a hotkey key to change directly to Freehand DrawMode 

Line  
Set a hotkey key to change directly to Line DrawMode 

Lasso Fill 
Set a hotkey key to change directly to Lasso Fill DrawMode 

Poly Fill 
Set a hotkey key to change directly to Poly Fill DrawMode 

Rectangle Fill 
Set a hotkey key to change directly to Rectangle Fill DrawMode 

Sculpt Brush Fill Backfaces 
Set a hotkey to temporarily enable the Fill Backfaces option during a brush stroke when using 
one of the Fill Draw Modes. 
 

Sculpt Brush Pressure  
Hold to change just the pressure of the brush while moving your mouse or pen 

Sculpt Brush Pressure Decrease 
Decrease the pressure of the brush 

Sculpt Brush Pressure Decrease Big Steps 
Decrease the pressure of the brush in larger steps 

Sculpt Brush Pressure Increase 
Increase the pressure of the brush 

Sculpt Brush Pressure Increase Big Steps 
Increase the pressure of the brush in larger steps 

Sculpt Brush Size  
Hold to change just the size of the brush while moving your mouse or pen 
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Sculpt Brush Size Decrease 
Decrease the size of the brush 

Sculpt Brush Size Decrease Big Steps 
Decrease the size of the brush in larger steps 

Sculpt Brush Size Increase 
Increase the size of the brush 

Sculpt Brush Size Increase Big Steps 
Increase the size of the brush in larger steps 
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Paint Brush Limitations 
1) Only works on Polygon Objects 
2) Only paints on one selected object at a time 
3) Paints using the first found UV tag on the Polygon Object 
4) It will only paint on multiple channels if they are all the same size 
5) The Fill Draw Modes require intersecting points on the mesh 
6) Stamps require intersecting points on the mesh. 
7) No real-time texture bleeding over UV seams. But we have a one click solution to fix up 

any seams you might have 
8) Painting with large brushes on large textures (4k and up) will be slower. You can work 

around this by increasing your stamp spacing or just using the Fill Draw Modes 

Stamp Limitations 
Unfortunately due to a limitation in the sculpting system Stamps do not function well within 
single polygons. That is when the stamp is completely within a polygon and not touching any 
points at all on the mesh. 
 
For stamps to work correctly they must overlap at least 1 point on the mesh. To work around 
this limitation you can use the sculpting system to subdivide your model so that you have 
enough points on the mesh for the brush to hit a point while painting.  
 
Note that this workflow is not required for stencil painting and simply a limitation of the sculpting 
sdk for Cinema 4D 
. 

1. Switch to the sculpting tab 
2. Subdivide your model by using the Sculpting Subdivide button to give it more points to 

work.  
3. When you now paint on your model using a stamp it will hit at least 1 point and the 

stamps will be placed correctly. 
4. When you are finished painting you can simply delete the sculpt tag from your model. 

Fill Tool Limitations 
For the Fill Tools to work correctly you need to ensure that a point of the mesh that you are 
trying to fill is included in the selected area. An example of where the Fill Tools will fail is if you 
have a single polygon and try to fill part of it inside the polygon. This will result in no painting at 
all.  
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This is a limitation and we hope to resolve it in a future build but for now the fill tools must 
intersect at least 1 point on the polygons that you intend to fill. The brush is then able to check 
all the polygons connected to those points and apply the paint accordingly. 
 
As a workaround you can subdivide your model using the sculpting system to create more 
points in the area that you wish to paint. And then remove the sculpt tag after you have finished 
painting. 
 
 
No Painting will occur since the fill tool does not intersect a point on the mesh. 

 
 
Here painting will occur since the lasso fill contains a point on the mesh. 
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And here is the resulting paint projected down onto the polygons that the point is connected to. 

 

Subdividing to work around limitations 
Most of the limitations of the Paint Brush can be overcome by Subdividing the mesh using the 
Sculpting System. This will add more points to the object allowing brushes to intersect points on 
the mesh which results in different algorithms being used to correctly place down texture on the 
models.  
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Note: You can only paint on Sculpt Objects (Polygon Objects with a Sculpt Tag) when in Model 
mode. Sculpt Tool based brushes do not work on Sculpt Objects when you are in Polygon, Point 
or Edge mode. 
 
With your Polygon Object selected switch to the Sculpting Layout. 
 
Now select the cog button on the Subdivide button.  

 
 
Since we don’t want to change the shape of the object while painting we need to make sure it 
doesn’t smooth the surface in any way. So set the smoothness value to 0 and press OK. 

 
 
Now press the Subdivide Button a few times to get more polygons on your object.  

 
 
You don’t need to go very high. Just enough so that the brush will overlap points on the mesh is 
fine. 
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Delete Higher Levels if you subdivided too far. 
If you have subdivided too high and want to remove higher levels then you can do this from the 
Sculpting Tag. First go down to the subdivision level you want to be at by clicking the “Decrease 
Button”. Then double click the Sculpt Tag and press the “Delete Higher Levels” button.  
 
The Sculpt Tag looks like this on your object. Double clicking this tag will switch to show the 
sculpt layer manager. 

 
 
This image shows the Decrease button and the Delete Higher Levels button. 
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Press OK when the warning message appears. It is simply stating that this operation is not 
undoable, which is ok for this situation. 

 
 

 

 

  

 

Copyright © 2016 GameLogicDesign Ltd  Version 1.1.9 

 



 
 

Disable Phong Shading 
If the shading looks wrong then you can double click on the Sculpt Tag to bring up the Sculpt 
Layer Manager, from here you can disable Phong Shading. 

 
 
Uncheck the Phong option on the Sculpt Tag to remove phong shading. 

 
 
Model without phong shading 
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Content View 

 
The Content View dialog is specifically designed for texturing, sculpting and painting workflows. 
 

Content Browser Tab 
In it you will find all the textures that ship with your copy of Cinema 4D. These can be found 
under the Content Browser tab.  
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Working with the Content Browser images 
Single Click on any image to set the Paint Brush Stamp. If you have a sculpting brush active 
then this will set the Stamp on that sculpt brush. 
 
Ctrl+Single Click on any image to set the Paint Brush Stencil. If you have a sculpting brush 
active then this will set the Stencil on that sculpt brush. 
 
Double Click to open the image in the Picture Viewer. 
 
Right Click and choose “Use as Stamp” or “Use as Stencil”. This will set the stencil or stamp on 
your current sculpt brush or paint brush. 
 
Drag and Drop onto a Material on the UVPaint Material View to fill the currently active Layer, on 
that material, with the texture. 
 

 
 
Drag and Drop into the BP Texture Viewer to open as a texture. 
 
Drag and Drop into the BP Material tab to create a new material with this texture in its color 
channel. 
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Stencils and Stamps Tabs 
There are 2 custom Tabs that you can use to put in your own stencils and stamps. For image to 
appear in these tabs you simply add the folder where these are located to the UVPaint 
Preferences. 
 
These tabs have the same functionality as the Content Browser Tabs. 
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Material View 

 

Menu 

Layer Commands 

Add Layer 
Add a new Layer to every material on the object then switch to that layer so that you can start 
painting on it. 

Create Wireframe Layer 
Create a new layer on every material called “Wireframe”. It will then draw all the UVs that are 
assigned to each material onto their individual layers. 

Create Flood Fill Layer 
Create a new layer on every material called “Filled”. It will then fill all the UVs that are assigned 
to each material onto their individual layers using the color specifed in the BodyPaint Colors tab. 
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Fill Current Layer 
This command will completely fill all the currently active layers with the specified color.  

Fill Current Layer UVs 
Similar to the above Create Flood Fill Layer but this command will not add a new layer and 
instead just fill the current layer. It will respect the UVs and only fill the texture where UVs are 
specified on each UDIM. 

Fill UV Islands 
Fills each of the UV Islands, on every material, with a random color. 

Bleed All 
Bleeds out every layer, on every channel, on every material. You can set the bleed amount from 
the UVPaint Preferences. 

Add Channel 
All of the commands under this menu will add a channel to every material with a new texture 
applied to it ready for painting. 
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UDIM 

Create Single UDIM 
This will create a Single UDIM for the currently selected Polygons on your object.  

Setup UDIMs for Object 

 
 
If you import an object that already has its UVs setup for UDIMS, such as uvs going from 0-1, 
1-2, 2-3 etc… then you can use this dialog setup materials for each of the UDIMS and load in all 
the correct textures for each UDIM based on the file naming convention. 
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To load in the images for each UDIM you simply select a single texture from disk in a folder that 
contains all the textures for this object.  
The texture must have the UDIM number as part of its filename. It must also have the name of 
the channel which the texture should be assigned to in C4D.  
 
As an example, a file with this filename “Model_1006_color.tif” will be loaded into the color 
channel UDIM 1006. 
 
Then any other images in that same folder that will also be loaded onto other UDIM materials in 
their appropriately named channels. 
 
Also watch the following video: https://vimeo.com/182469952 

Texture 

The first filename of a udim in the folder where all the image are located. 

Create New Textures 

If enabled, and there is no filename specified, then it will create a new image in the color 
channel for every UDIM found on the model. 

Texture Tokens 

These allow you to change the name of the tokens to look for in the filename so that you can 
map them to a different channel on your material. 

Setup Selected  

Will create all the UDIM materials on the object. It will create a material and selection tag per 
UDIM and then assign all the textures found in the directory specified by the sample texture, to 
their appropriate channels. If no texture was specified and “Create New Textures” is enabled 
then it will create a new blank texture for the color channel. 

Load Textures 

If you already have UDIM materials on your model but you have a second list of textures for 
different channels then you can use this button to just assign all the channels in the specified 
directory to the already existing UDIM materials on the object. 

Cancel 

Close the dialog without doing anything. 

UDIM Per UV Island 
This will map each separate UV Island on the objects UV Tag to its own new Material.  
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Each material will be assigned a selection tag containing all the polygon for that udim. 
 
All the UVs for that UDIM will be mapped to the appropriate UDIM space. For instance any 
polygons on UDIM 1001 will be from 0 to 1. But any UDIMS on 1002 will be from 1 to 2. 

UDIM Per Polygon 
This is a bonus feature and should be used with great care.  
 
This will create a new Material for EVERY polygon on your object. It will also create a new 
textures at the resolution specified in the UVPaint Preferences and assign it to the color channel 
for this object.  
 
 
Each of the Polygons UVs will be mapped to the UV space for the UDIM.  IE polygon 1 will be 
0-1 on udim 1001, polygon 2 will be 1-2 on udim 1002, polygon 3 will be 2-3 on udim 1003 etc…  
 
A new Selection tag will be created that assigns the each polygon to its given material. 

Standard 

Create Single Material 
If you have selected polygons then it will create a new material and assign those UVs to that 
material via a selection tag. All the UVs will be mapped from 0 to 1 and scaled to fill up the UV 
space. 
 
If you have no polygons selected then it will create a new material and assign all the uvs to this 
one material. 

Material Per UV Island 
Creates a new material for every UV Island on the model. It will assign the UVs for each Island 
to its own Selection Tag. It will then scale the UVs so that the Islands takes up all the UV space 
,between 0 and 1, on this material.  

Material Per Polygon 
This is a bonus feature and should be used with great care.  
 
This will create a new Material for EVERY polygon on your object. It will also create a new 
textures at the resolution specified in the UVPaint Preferences and assign it to the color channel 
for this object.  
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Each of the Polygons UVs will be mapped to 0 and 1. A new Selection tag will be created that 
assigns the each polygon to its given material. 

Commands 

Select Edges 
When in Polygon mode it will select all the polygons on the edges of the UV Islands. 
 
When in Edge mode it will select all the edges of the UV Islands. 

Flip UVs Vertical 
If you have loaded in an Obj file that has multiple UVs then the UVs may not be in the correct 
direction. 
 
With your object selected simply press this button once to correctly flip all the UVs so that they 
reside in the correct location in UV space so that the UDIMs can be applied. 
 
Note: This should be called BEFORE you setup the UDIMs or use the ‘Setup UDIMs for Object’ 
dialog. 

Right Click Menu 

 

Paint All 
Quickly enables everything required to allow painting with the Paint Brush.  

- It will automatically set the “Texture Preview Size” for every material to be “No Scaling”. 
- Activates all the Materials so that it can be painted on. 
- Activates the current channel that is being viewed to be painted on. 
- Ensures that a layer is selected on each of the material.  
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After selecting this option the view will switch to shaded mode and the BP brush will be 
selected.  
 
Simply select the UVPaint: Paint Brush to switch back to OpenGL view and start painting on the 
model across all the materials. 

New Material 
Create a new Material from the selected Polygons on this Material and map them so that they 
take up the full size of the new texture. All channels and layers will be copied from this Material 
and added to the new one. All textures will be remapped to preserve any painting that has 
already been done. 
All the UVs for the selection will be remapped between 0 and 1. 

New UDIM 
Create a new UDIM from the selected Polygons on this Material and map them so that they take 
up the full size of the new texture. All channels and layers will be copied from this Material and 
added to the new one. All textures will be remapped to preserve any painting that has already 
been done. 
 
All the UVs for the selection will be remapped to the location of this new UDIM. 

Select Edges 
When in Polygon mode it will select all the polygons on the edges of the UV Islands. 
 
When in Edge mode it will select all the edges of the UV Islands. 

Flood Fill 
Flood fills all the polygons on the current layer of this material with the color specified in the 
BodyPaint color tab. 

Delete  
Deletes the Material and its Selection Tag. 

Bleed 
Bleeds out the texture on the selected layer on just this single Material. 

Bleed Active Layers 
Bleeds out all texture on the selected layer for ALL the materials on this object.  
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Note: If you wish to bleed out every layer on every channel on every material, then you can do 
so by using the “Bleed All” option from the side menu of the Material View. 

View Channel 
Change the current channel that should be displayed in the view 

View Layer 
Change the current layer that should be displayed in the view. 

Hide/Show Layer 
Hide or Show a layer on the object.  
 
Note: Sometimes it may be necessary to move your mouse in the OpenGL viewport before 
Cinema 4D will update the textures. 

Watch the Videos 
There is a lot more that this brush is capable of. But instead of documenting it here we have 
made a series of tutorials that you can find on the Paint Brush product page. Please refer here 
for more information. We will be creating more videos in future to help explain any issues and 
questions that you might have. 
 
http://www.gamelogicdesign.com/Products/TabView?productName=UVPaint 
 
UV Paint Videos: https://vimeo.com/album/4144746 
 
UV Paint Sneak Peek Beta Videos: https://vimeo.com/album/4144744 

Report any Issues or Feature Requests 
If you find any issues with this document, or the plugin, please don’t hesitate to contact us at 
support@gamelogicdesign.com and we will fix any problems as quickly as possible.  
 
We will also be creating a series of tutorial videos to help show what is possible with this plugin.  
 
Please check the website page for this product for more information. 
 
If you have any requests for any content either for this document, or tutorial videos then also let 
us know. 
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